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Standard Terms and Conditions of Use
 

Life Support and Safety Equipment:ÊPersistor Instruments Inc. (Pii) hardware, software, and
firmware products are not warranted to operate without failure or designed with components or testing
suitable for reliable use as critical components where failure to perform can reasonably be expected to
cause loss of life or significant harm to humans. Designers of diagnosis, treatment, life support, or safety
equipment systems for humans using Pii products must take prudent steps to protect against system
failures with the appropriate backup, redundant, or fault tolerant mechanisms.

Specifications:ÊProduct features and specifications are subject to change without notice and Pii
reserves the right to make any product improvements at any time. Pii is not responsible for errors or
omissions in published documents.

Limited Warranty:ÊPii warrants that its hardware products against any defects in materials and
workmanship under normal and proper use that would prevent them from meeting published performance
specifications at the time of purchase for one (1) year from the date of purchase. This warranty does not
cover depreciation or damage caused by normal wear, accident, improper use or maintenance. Persistor
Instruments Inc.warrants that its firmware and software products will perform substantially as described
in published materials accompanying its hardware products for a period of ninety (90) days from the date
of purchase.

If found defective by Pii within the terms of this warranty, the full extent of Pii's liability and your
exclusive remedy will be, solely at Pii's option, to either repair, replace, or refund the purchase price of
the product that does not meet Pii's limited warranty provided that (a) the defective product is promptly
returned to Pii for failure analysis, (b) a complete description of the failure accompanies the product, and
(c) no evidence is found of damage from accident, neglect, misuse, or improper alterations of the product.
TO THE MAXIMUM EXTENT ALLOWED BY LAW THIS EXPRESS WARRANTY IS IN LIEU OF,
AND BUYER EXPRESSLY WAIVES ALL OTHER LIABILITIES, OBLIGATIONS, GUARANTEES,
AND WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT
LIMITATION, ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF TITLE OR NON-
INFRINGEMENT. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY
ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

Limitation of Liability:ÊTO THE MAXIMUM EXTENT ALLOWED BY LAW, IN NO EVENT
SHALL PII OR ITS SUPPLIERS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES, INCLUDING WITHOUT LIMITATION INJURY OR DEATH,
LOST OR INADEQUATE DATA OR INFORMATION, LOST REVENUES OR PROFITS, LOST USE
OR BUSINESS INTERRUPTION, REPLACEMENT OR RENTAL COSTS ARRISING FROM THE
FAILURE OF, OR INABILITY TO USE PII PRODUCTS. IN NO EVENT SHALL PII'S LIABILITY
FOR ANY DAMAGES EXCEED THE PURCHASE PRICE OF THE PRODUCT.
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General Information
Introduction

This getting started guide describes how to setup and install the various components that make up your
Persistor CF1 Starter Kit. This printed manual stops at the point where you’ve installed the online HTML
and PDF documentation, though we’ve included some diagrams and tables that you may find handy in
working with the Persistor.

The combination of a Persistor and RecipeCard let you quickly start working on your experiment goals
without putting a lot of front-end effort into wiring up the hardware. In many cases, this will be all you
need for the initial prototype, proof-of-concept, or feasibility studies. The RecipeCards come with
complete schematics, parts lists, and design notes for when and if you decide to move portions to your
custom board.

What’s in the Kit?

Your CF1 Starter Kit should contain the following items:

1 PERCF1C Persistor CF1
1 PCF8MBC 8MB CompactFlash Card
1 PCFADAP PCMCIA Adapter Card
1 PRCPDAQ PicoDAQ Analog RecipeCard
1 CBL10H10DB9 10” DB-9 Serial Adapter Cable
1 CBL30CG4TL 30” Power Cable to Tinned Leads
3 SHNTJMPS Shunt Jumpers
3 CGPINS Space C-Grid Connector Pins
1 MXWCF1 MotoCross for CF1 (CD-ROM)

Equipment Required

4-20VDC, 100mA power supply
PC running Win95/98/NT or Macintosh with System 7 or above with free serial port
Metrowerks CodeWarrior and MotoCross for CF1

Warnings and Precautions

We really don't want to dampen the excitement of exploring your new board, but there's some stuff you
really ought to know. Even the old-timers may find something new to worry about with this new 3.3 volt
system and its lowest power suspend mode. Just take a minute to skim this short section and save the
possible embarrassment and expense of having to admit you leaped before looking.
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3.3V I/O: The CF1 is a 3.3 volt only system, and cannot tolerate any voltages above 3.6 volts on any of
its I/O or BUS lines, except for the RS-232 signals (RSTXD, RSRXD, RSCTS, RSRTS). Even
momentary connection to 5 volt signals will likely result in permanent damage to the board’s components.
Do not attempt to get around this by running the board at 5 volts as the RAM, and especially the flash
will suffer stress damage!

Suspend Mode: When the CF1 goes into suspend mode, all of the I/O and BUS pins (except for the
RS232, /WAKE, and /SHDN) look like very low impedance current sinks with about a 1.3-1.8 volt
forward drop. CF1 I/O or BUS lines being driven from off-board peripherals will try very hard (and
succeed) at pulling these levels low, which is probably not what you want. Any I/O lines being pulled
high to an external V+ source will be pulled down to this forward voltage drop. Both of these situations
will consume lots of current which defeats the purpose of suspend mode.

Static Sensitive CMOS: Every component on the CF1 is CMOS and susceptible to immediate damage,
or worse, premature field failures if you don't take precautions to guard against damage from static
electricity.

Develop with a current limited power supply! You can save yourself a lot of grief by running the board
from a bench supply current limited to about 100mA. Jumpers, test probes, and programming bugs make
it very easy to send the CF1 into some horrible current sucking latchup and current limiting can keep a
spurious slip from destroying your board.

Develop at low voltage! The CF1 onboard voltage regulator can handle +/-20 volt inputs, but nothing
else on the board can. Just like current limiting, developing at around 4 volts is a good way to keep a
simple slip from destroying your board.

Floating Inputs: Most of the I/O lines on the CF1 do not have onboard pull-up resistors, and most of
these are left in their default input state at reset. CMOS floating inputs draw current in somewhat
unpredictable fashion - nowhere near enough to do any damage, but enough to defeat the gains of some of
the power saving modes. You should either pull unused I/O lines to VREG or GND, or force them to be
outputs.

Don't Stick Probes in the Header Sockets: The header strips used in the RecipeCards are meant to
accept 0.025" square posts. Anything else is likely to permanently deform the connectors and cause your
system to fail or behave erratically. We did this here with a scope probe tip (0.037" diameter), and a
customer did it with a miniature DMM probe (0.044" diameter). We both spent many frustrating hours
searching for the source of bizarre problems. The deformation damage is quite visible, but only with the
help of a microscope - and no, this would not be covered under the warranty.

Backup battery is required: The CF1 depends on a separate PIC microcontroller to manage startup,
power-off watchdogs, suspend mode, and CF card changes. Even if you're not using the last three
features, you probably want the CF1 to start up when you apply power - and that's not guaranteed unless
there is voltage at the VBBK pin during power-up. If you really don't want to provide a backup cell, you
can connect separate 3 volt regulator between your main supply and VBBK.
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Installing CodeWarrior

Your first step toward developing with the CF1 is installing Metrowerks® CodeWarrior®. This section
explains how to install CodeWarrior Release 6 for use with MotoCross® libraries and support tools for the
CF1. Follow the instructions on these four pages (mostly pictures), then perform the simpler MotoCross
installation. If you follow these installation instructions to the letter, you should be running your first
MotoCross program in less than an hour.

To use the MotoCross package, you will need:
1) Metrowerks CodeWarrior Pro - Release 6 (or later)
2) 32MB RAM, 120MB Free Disk Space, CD-ROM
3) Pentium-class processor (recommended), 80386, or 80486
4) Windows NT 4, Windows 95, or Windows 98

MotoCross requires that you install CodeWarrior using the Metrowerks CD installer with any of their
options to build MacOS-68K projects. If you have an existing installed CWPro and can compile MacOS
68K applications, you can skip this section and resume with the CF1 Getting Started Guide. If you're
using CodeWarrior solely for CF1 development, you need only select the options checked in the screen
captures below, which will require about 160MB of disk space.  Keep an eye on the Space Required and
if it varies a lot from the screen snapshots, carefully review your selections. If you have trouble, it’s
perfectly safe to reinstall CodeWarrior in part or whole, and that generally will get you going.

CD Installation

Start by inserting the CodeWarrior CD. On most
PCs, you will automatically be presented with the
installation dialog. On some others, you will have
to double click on the CD icon to get things
started. Pay attention to the following note from
the Metrowerks documentation:

"The installation software on CodeWarrior
Professional can't successfully install a new
version of CodeWarrior if an older version of
CodeWarrior already exists on your computer.
To remove the old version of CodeWarrior,
launch the Uninstall CodeWarrior program.
This program is available from the Start
menu."

That done, click the Launch CodeWarrior Setup button. Then work your way through the next several
information dialogs...
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Destination

You're best off just accepting the
default directory offered by the
installer. You can actually put
CodeWarrior anywhere, though all of
the other CF1 documentation and
installers will reference locations to
the standard default. The actual
location of the CodeWarrior program
files does not matter a great deal, as
you will not actually be working in
this directory. In fact, the Metrowerks
directory is a particularly bad place to
keep your own projects as they can get
inadvertently deleted when you
upgrade to the next release of
CodeWarrior. This is covered in more
detail in the getting started
documentation.

Select Components
Using the screen snapshots as a guide…
1) Setup Type

a) Click-select “4. Custom Installation”
b) Click Next>

2) Select Components
a) Check “CodeWarrior IDE”
b) Check “PPC-68K Development”
c) Click Next>

3) Select Program Folder
a) Click Next>

4) Select File Associations Option
a) Choose “Typical: Selected…”
b) Click Next>

5) Start Copying Files
a) Click Next>
b) Wait for the copy to complete

6) Register CodeWarrior
a) Fill out the registration information
b) Click Next >

7) InstallShield Wizard Complete
a) Click Finish>
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Installing MotoCross

After you've installed CodeWarrior, insert the Persistor CF1 Tools CD and double-click the Setup.exe
icon to run the MotoCross Installer. If you followed the destination suggested by CodeWarrior, our
installer will just require a few clicks on the "Next" button to complete installation. Here's what it should
look like:
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Location, Location, Location

After installing CodeWarrior and MotoCross,
you should have something that looks like
what's adjacent. CodeWarrior is very fussy
about the relative locations of its various
components, and the preconfigured MotoCross
stationery makes similar location-relative
assumptions. If things get moved around, expect
your compilations to start failing.

Fortunately, you won't be doing much inside the
CodeWarrior directory. All of your work should
be done in completely separate directories with
whatever convention you find best. For our
projects, we typically use:

C:\piisoft\CF1\

You can even have projects scattered over many
directories or drives. The main point is:

Don't put your projects in the Metrowerks
directory!

They will be lost when you install updated
versions of CodeWarrior, and this is likely to
happen a couple of times a year. Even though
MotoCross installs and lets you run example
programs in the Metrowerks directory, it knows
you can recover them by simply reinstalling
MotoCross. This is not the case for your
projects and the source files you create.

The only things that should go into the
Metrowerks directories are installations from
Metrowerks and Persistor Instruments. You
should also always assume that files in the
Metrowerks directory will get deleted during
update installations.
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Hookup and First Run

There are several jumper pins on the RecipeCard and these come pre-configured to select default options
that let you quickly try out your new system. You’ll need to insert the CF1 into the sockets on the
RecipeCard. This is very difficult to do incorrectly. If you have any doubts, look at the picture on the front
cover.

Insert the power and RS-232 cables into their respective headers. These are shrouded and polarized to
prevent incorrect insertion. Connect the red lead of the power cable to your supplies positive terminal and
connect the black lead to negative. The power cabling uses Molex C-Grid connectors and these are
available from DigiKey and Allied among others.

The RS-232 cable adapts the RecipeCards 2x5 dip header to a
standard DB-9F that connects to standard PC comm port or
extension cable. The cable wires the 2x5 connector such that pin 1
of the DB9 connects to pin 1 of the 2x5, and all of the other 2x5
connections are setup such that they map correctly to a standard
DCE as shown.

If you haven’t installed MotoCross yet, but  already have a communications program on your PC you can
give the Persistor a quick try by setting your communications program for direct connection, 9600 baud,
no parity, 8 data bits, and 1 stop bit. Apply power to the Persistor, and you'll probably see something like
the following:

--------------------------------------------------------------
Persistor CF1 - Persistor Instruments Inc. - www.persistor.com
     SN 10945 - PicoDOS V2.26 - BIOS V2.26 - PBM V2.26
        (C) 2000 Peripheral Issues - www.periph.com
--------------------------------------------------------------

C:\>

The PicoDOS prompt is a standard DOS-like drive identifier when a flash card is installed. When there’s
no card, PicoDOS displays a warning that many functions are disable and reverts to the PicoDOS prompt.
From either prompt, you can type the VERsion command with the –Verbose option for system details as
shown:

C\>VER –V <ret>
CF1 SN  10945
PicoDOS 2.26
BIOS    2.26
PBM     2.26
PIC     1.44

Typing HELP will always give you a list of the available PicoDOS commands
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CF1 C Programming Tutorial

So, you've gotten your Persistor out of the box hooked up and ready to go. Now it's time to find out what
the CF1 can really do. This tutorial assumes that you have followed the correct installation procedure for
both CodeWarrior and MotoCross. If CodeWarrior is not installed or MotoCross is installed improperly,
this tutorial will be of little utility.

Your First Project

To begin, launch CodeWarrior. Select File ->
New Project. A "New" window will appear
allowing you to select from a list of stationery.
You will see options for several types of
projects, but for now just choose Persistor CF1
Stationery. Type the desired name (we'll use
FirstCF1Project) in the Project Name box and
click "OK". The next "New Project" window
will ask to specify which type of CF1 project
you want, and you should expand the appropriate
CodeWarrior version (probably CWPro6) and
choose CF1.PicoDOS and click "OK".

Once the above steps are completed, you will be
presented with a CodeWarrior Project window. There
are several "groups" within the project window. These
are merely organizational tools and do not reflect any
"on disk" structure for the project. When first opened,
these groups are collapsed and you can click on their
expander controls (the boxes on the left) to view the
files in the groups. The two snapshots at right show the
same project with different expansion levels. We'll go
through the groups one by one ahead:

1) MotoCross Support - This group
contains several libraries crucial to
compiling projects for the CF1.
These files include a special version
of the C standard library and math
support library for the CF1 and a
special startup library that sets up
your C program to run in the CF1
environment. You will generally
never make changes to this group or
to the files in this group.
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2) CF1 Support - This group contains a
pair of C files that control runtime
memory mapping and provide some
interface support between the CF1
firmware and the standard C libraries.
You will generally never make
changes to this group or to the files in
this group.

3) Docs - This group is the key to easy
development on the CF1. In this
folder are links to starting points for
all of the on-line documentation for
the CF1. Bear in mind that you will
need to have Adobe Acrobat as well
as a modern web browser like
Explorer or Netscape installed on
your machine for this to work. There
are two HTML files accessible to you
in the folder.
PersistorCF1UsersManual.htm is
the master link to the user’s manual.
You may just double click that file
directly in the window to launch your
web browser and begin viewing the
manuals. ctm.htm is a link to the
Configurable Timer Documentation.
In addition, in the Docs folder you
should see a pdf folder. This folder
contains links to most of the
hardware and part-level
documentation that we provide in
PDF format that can be read with
Adobe Acrobat.

4) Headers - This folder contains links
to the main header files used in
development for the CF1. If you need
to look up any function prototypes or
typedefs used with any of the
Persistor API functions or PicoDOS, you can find those files here. Once again, you can open the files
by simply double clicking on them.

5) Application - This is the folder where you can store all of your application source files. You will
notice that it already contains a file called cf1main.c. This is a starter file that we have provided to
help make it easier for you to begin development. It contains the all of the standard ANSI header file
includes as well as all of the device specific includes that you will need to work with the CF1.



ÊPersistor CF1 Getting Started Guide 15

Once you become familiar with CodeWarrior and CF1 development, you can begin to tailor the
organization of projects to meet the specific needs of your application. The format described above works
well for most projects, but just like the arrangement of files on your PC desktop, it's really just an
organizational convenience.

A Note About Targets

Metrowerks CodeWarrior has a special
feature that allows "multiple targets" in one
project file. This allows us, in our examples
to keep related, yet separate projects
together in one file for organizational
purposes.

To pick a particular target use the target
pull-down menu in the project window
located beneath the Files tab at the top of the
window. The left edge of the menu has a
bullseye with an arrow pointing at it.

Some multi-target projects send the
compilers object and binary data to either a
"bin" directory, or into a directory named
"<PROJECTNAME> Data". Point
MotoCross to one of these if you do not see
the binaries in the main project directory.
However, if you use our project stationery
this should not be an issue.

YYYYoooouuuurrrr    ffffiiiirrrrsssstttt    pppprrrrooooggggrrrraaaammmm

The default C project stationery contains a
simple bit of code that prints out the serial
number of your CF1 as well as information
regarding the program build and the
versions of the BIOS and PicoDOS that are
burned into your Persistor's flash. You may
wish to look at the file cf1main.c before
compiling it. Once you are comfortable with
the code you see select Project -> Make. If
everything is installed correctly this should
build a binary executable that the MotoCross program can then load into your CF1.
During the build, the files and groups in your project window will update with information about the size
of the code and data required for each module as shown. These numbers reflect the worst case usage, and
the smart linker will generally reduce that by quite a bit. Map files created by CodeWarrior and
MotoCross give complete details on memory usage and mapping.
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You can run MotoCross by double-clicking
the MotoCross.exe file at the top of your
project window's list of files. Select
MotoCross -> Post Link and Load… then
navigate to your project's bin directory and
select the file with the ".bin" extension. In a
few seconds, MotoCross will load the file
into the CF1 and leave you in its terminal
window where you'll see something like the
following.

This prompt indicates that the code was loaded into your CF1 and the G (which was automatically sent by
MotoCross) is an abbreviation for the GO command that will launch your program. At this point, if you
press Enter, your program will execute.

WWWWhhhhaaaatttt    HHHHaaaappppppppeeeennnneeeedddd????

Congratulations, you have just compiled
and run your first program for your CF1.
When you chose the CF1.PicoDOS
stationery and gave it the name
FirstCF1Project, CodeWarrior created a
new folder and populated it with the project
file (FirstCF1Project.mcp), a starter C
source file (cf1main.c), a project data folder
(FirstCF1Project Data) and a bin folder to
hold compliled binary code. CodeWarrior
also automatically opened the project and
added it to the list of recent projects so you
can quickly open it again from the File
menu.

When you chose Project -> Make,
CodeWarrior checked all of the file
dependencies, compiled all of the C source
files, then linked the C code with the
libraries. If it had found any errors, it would
have displayed an error window with a list
of problems for you to fix by double-
clicking on the error message.

There were no errors, so it created the binary file (unnamed.bin) that thinks it is a Macintosh 68K
executable, along with a map file that specifies the locations of functions and global variables in a not-so-
useful relative offset format. Because CodeWarrior thinks in terms of creating Macintosh programs, it
also generated a few other items which you can safely ignore, including a zero length file (unnamed), and
a possibly invisible directory called Resource.frk.
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When you ran MotoCross and post-linked unnamed.bin, MotoCross created six new files that are the real
targets for the CF1. The file with the extension RUN is a CPM68K binary file, and it's what loaded into
RAM and ran on the CF1. The APP is the same program, but targeted to load into flash memory when
you use the MotoCross ->Load CPM68K… command.

The RHX and AHX files are also applications, but in Motorola S Record (hex) format. The RMP and
AMP files contain text listing the functions and global variables, exactly as they are used on the CF1. You
can open and read these maps directly from CodeWarrior.

BBBBeeeeyyyyoooonnnndddd    SSSSttttaaaannnnddddaaaarrrrdddd    CCCC    LLLLiiiibbbbrrrraaaarrrriiiieeeessss

As you may have read elsewhere, the CF1 supports the ANSI C Standard Library. This fact should put an
experienced C programmer well on their way to writing more meaningful and useful programs for the
CF1. However, it is unlikely that you bought the CF1 solely to write programs with the C Standard
Library. You probably want to take advantage of the CF1's I/O features, low-power operation and more of
its many specialty subsystems. The following is a blow-by-blow description of the major hardware
subsystems in the CF1.

CCCCFFFF1111    HHHHaaaarrrrddddwwwwaaaarrrreeee    SSSSuuuubbbbssssyyyysssstttteeeemmmmssss

The CF1 as an embedded controller is very diverse and agile. It can do almost anything. There are many
different sections of APIs for accessing each of the internal capabilities. The following is a list of the
major subsystems that you will find described in further detail in the online User's Manual.

ATA Device Drivers - The CF1 API has a suite of functions that allow you to manipulate ATA storage
devices (usually CompactFlash) from within your programs. Although most developers will never have a
need to use these in light of the standard file routine compatibility, they are nonetheless provided for your
programming convenience.

CompactFlash Low Level Drivers - The CompactFlash Low Level drivers cover programming needs
specific to CompactFlash card management and use. It is unlikely that you would ever use these but they
are provided as an additional abstraction layer between the hardware and the ATA device drivers.

Checksums and Cyclic Redundancy Check Functions - Because many CF1 applications involve the
transfer of data between the CF1 and a host computer as well as any other mating systems, there is often a
need for error checking and data integrity tests. These functions provide a built in mechanism for
performing checksum verification and cyclic redundancy checks.

Chip Select Drivers - One of the more interesting and distinguishing features of the CF1 is the ease with
which you can add memory-mapped peripherals. The functions in the API subsection provide relatively
high level mechanisms for mapping and configuring the two bus chip select lines that are available for
your use. Examples are also provided which make use of these functions for mapping in new I/O. See the
examples folder in the User's Manual for more information on this specific example.



ÊPersistor CF1 Getting Started Guide 18

Configurable Timer Module - The CF1 uses the Motorola MC68CK338 processor as its main brain. The
'338 contains several hardware submodules that are specifically tailored to the common tasks in
embedded computing. One of these submodules is the Configurable Timer Module. While it is one of the
more complex subsystems in the '338, we have attempted to provide high-level accessor function to all of
the features of the CTM6. The CTM contains both Single Action and Double Action modules that can
perform tasks such as period measurement and Pulse Width Modulation. For a more detailed description
of the CTM please see the included HTML documentation from Motorola which you will find in the same
directory as your user's manual.

Flash Memory Functions - The CF1 has 1MB of non-volatile flash memory built-in. This is used to hold
both the BIOS libraries and PicoDOS as well as other system internals. However, there is about 768K free
for non-volatile application storage or data storage if you find the need. Because flash memory has special
requirements and does not support random access unlike conventional RAM, we have developed a suite
of functions that perform the writing and erasing tasks on the flash as well as other maintenance chores
and diagnostic utilities. If you wish to develop programs that will make use of the Flash, you will need to
familiarize yourself with this section in the User's Manual.

Interrupt and Exception Vector Wrapper Functions - We recognize that many applications in
embedded computing are time sensitive or could be best serviced by a hardware or software interrupt
mechanism. These functions provide you with a simple, easy to understand method for creating your own
interrupt handlers written in C. We also provide functions that install your new interrupt handlers, written
either in C using our prototyping and definition tools or written directly in assembly language, in to the
Vector Table of the 68338.

LED Signal Functions - The CF1 has two dual color LEDs mounted near the sides of the Compact Flash
header. They can be used as simple indicators of program status, as a visual watchdog or whatever else
you can think of. This set of simple, almost self explanatory functions control the state and behavior of
these LEDs making it easy for your programs to provide the most minimal of visual feedback.

Pin I/O Drivers, Functions and Macros - These functions and macros allow you to control and
manipulate the behavior of the CF1's 33 general-purpose I/O lines. Some of the I/O pins on the CF1 have
alternate functions related to other subsystems. This section contains functions that allow you to
manipulate these alternate functions and correctly manage the use of the I/O pins on connector C on the
CF1. Furthermore, there is a set of macros that provide ultra high-speed access allowing you to perform
basic pin operations in under a microsecond with certain restrictions.

Periodic Interrupt Timer - Another hardware feature of the Motorola MC68CK338 is the Periodic
Interrupt Timer or PIT. The PIT allows the '338 to trigger an interrupt on a set period. The period can be
adjusted in increments of 100 microseconds from 100µs to 25.5ms and in increments of approximately
51ms from 51ms to around 13s. The CF1 API also proved a chore management system for the PIT
allowing you to perform more than one chore, written in standard C with no special considerations (other
than speed), on each interrupt and to shield the programmer from the necessity of writing low-level
interrupt handlers.

PicoDOS Library Functions - Providing that PicoDOS is resident in flash in your particular application,
which is normally the case, you can access most of the core functionality of PicoDOS from within your
applications. Also provided is a subsystem called CMD processor which provides a deep and valuable
framework for setting up a command line interface to your program. The CMD Processor allows your
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program to accept commands from a user interactively over the serial port, parse their arguments and
dispatch the appropriate function. This can be a huge time saver if you want your program to be
interactive.

Power Management Drivers - One of the more crucial features of the CF1 is its low power consumption
with non-executing power-down modes as low as 5 µA, The CF1 really is a low-power panacea for the
embedded system designer. This driver section gives you access to all the different power modes and
power conservation functions the CF1 has to offer. There are many ways to reduce power in an embedded
system. In this API section we have attempted to provide an intuitive management scheme for these many
and diverse options.

Queued PicoBUS - Another Persistor Exclusive. The Motorola QSPI bus is a powerful way to add
peripherals such as A/D converters and various other sensors to an embedded system. Until now there
hasn’t been an intuitive, managed, yet performance oriented software layer to control and manage this
bus, but PicoBUS has solved this problem. The QPB API allows you to configure and manage your SPI
devices. Furthermore, our internal library of device configurations is growing all the time. We may
already have done some of the groundwork for the device you want to use.

Real Time Clock Drivers - The 68338 has an onboard Real Time Clock (RTC) that has its own precision
crystal and its own power lines to allow ultra-reliable operation and persistence through low power
shutdowns and hardware reset cycles. This suite of API functions gives you access to setting and reading
this clock. It also provides its own periodic interrupt much in the same way as the PIT but it is fixed at 1
second intervals. Furthermore, it is worth noting that all of the ANSI C time-related functions are linked
in at a low level to the RTC, so it is more than possible that you will never need to use these driver
functions.

Serial Controller Interface Driver - The serial controller interface (SCI) is the main line of
communication with the outside world during development. It consists of a low-level driver for the
onboard UART and line drivers. Once again all of the ANSI C stdio functions are built on top of this
driver but if power conservation is your game you may need to use some of these low-level calls to
configure the UART in a specific way to help meet your design needs. We have attempted to cover all of
the bases in this driver, from normal operation to the lowest power modes.

System Clock and Wait State Management - One of the easiest ways to conserve power in an
embedded controller is to turn down the speed. Power consumption in a processor varies almost linearly
with speed, and we provide functions for you to adjust the system clock anywhere from 160KHz to
16MHz and beyond. Right there you can reduce your power consumption by an order of magnitude.
Furthermore, these functions provide a great level of control regarding the wait states and access speeds
of the various bus peripherals. If you are interested in measuring and characterizing the performance of
your CF1, you may wish to see our example program called Hurry Up and Wait. This program provides
a great example of how to change the system clock and the number of wait states used with each
peripheral.

Utility Functions - Lastly, there are functions that don't seem to fit anywhere else. These functions
include a hexdump function that can be extremely useful during development and other useful, but
difficult to classify functions.
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SSSSppppeeeecccciiiiffffiiiiccccaaaattttiiiioooonnnnssss
AAAAbbbbssssoooolllluuuutttteeee    MMMMaaaaxxxxiiiimmmmuuuummmm    RRRRaaaattttiiiinnnnggggssss

VBAT to GND............................................................................................ ±20V
VREG and VBAT to GND ......................................................................... ±20V
Digital Signals to GND ..................................................... -0.3V to VREG+0.3V
Operation Temperature............................................................. -25°C to +75°C
Storage Temperature................................................................ -40°C to +85°C
Humidity: ........................................................................... 0 to 95% (non-cond)

PPPPhhhhyyyyssssiiiiccccaaaallll    SSSSppppeeeecccciiiiffffiiiiccccaaaattttiiiioooonnnnssss

RETEMARAP IS SU
thgieW zo1<

draCFChtiw zo2.1<
htgneL mm5.36 ni5.2
htdiW mm5.53 ni4.1

draCFChtiw mm0.15 ni0.2
ssenkcihT mm5.41 ni75.0

EEEElllleeeeccccttttrrrriiiiccccaaaallll    CCCChhhhaaaarrrraaaacccctttteeeerrrriiiissssttttiiiiccccssss

RETEMARAP SNOITIDNOC NIM PYT XAM STINU
Am04taC°57+otC°52- 6.3 02 V
Am57taC°03+otC°52- 6.3 02 V

egatloVgnitarepOTABV Am57taC°57+otC°52- 6.3 8.21 V
Am052taC°03+otC°52- 0.5 4.8 V
Am052taC°57+otC°52- 0.5 0.6 V

egatloVgnitarepOGERV 1.3 3.3 6.3 V
etirWFCtnatsnoCzHM61 001 521 Am

)eldIFC(zHM61 55 07 Am
)eldIFC(zHM8 23 04 Am

tnerruCgnitarepOGERV )eldIFC(zHM4 02 52 Am
)eldIFC(zHk023 4 01 Am
)eldIFC(POTSPL 003 005 Aµ

)FCon(POTSPL 042 004 Aµ
dnepsuS 6 02 Aµ

egatloVgnitarepOKBBV 7.2 0.3 GERV V
tnerruCgnitarepOKBBV dnepsuS/pukcaB 8.2 02 Aµ

KBBV>GERV 1.0 1 Aµ
kcolCmetsyS 061.0 61 zHM

latsyrCLLP mpp001± 699.93 000.04 400.04 zHk
latsyrCCTR mpp05± 667.23 867.23 077.23 zHk
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BBBBlllloooocccckkkk    DDDDiiiiaaaaggggrrrraaaammmm    aaaannnndddd    SSSSiiiiggggnnnnaaaallll    CCCCoooonnnnnnnneeeeccccttttiiiioooonnnnssss
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oB .edomniardneponietareponactahtBepyT
xxP... .xxeulavforotsiserpu-llupdraobnosaH
GxxP... .xxeulavforotsisernwod-llupdraobnosaH
ISR... .tupnilevel)AIE(232-SR

OSR... .tuptuolevel)AIE(232-SR
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PPPPiiiinnnn    DDDDeeeessssccccrrrriiiippppttttiiiioooonnnnssss

The CF1 interfaces to your circuitry using three standard
double-row 0.1" headers. Many CF1 based systems will only
need to access the signals on the 2x25 pin "C" connector,
which brings out pins on both sides of the board (OEM
versions may specify pins on only one side or the other).The
2x10 "A" and "B" connectors bring out the address and data
bus along with control signals for system expansion.

The first ten pins of connector "C" form a standard BDM
(Background Debugger Mode) connector block at the top of the
CF1, and these are identified by a solid white silk-screen. In
addition, every fifth pin of connector "C" is marked with white to
help quickly identify the proper pin.

Pin type designations are taken from the MC68CK338 Technical
Summary, and where appropriate, suffixed with the value of
onboard pullup resistors or special notes.

Static Sensitive CMOS!  All of the CF1 pins connect to static sensitive CMOS circuitry. You must take
precautions to guard against damage to these parts from static electricity.

A langiS .cseD .riD noitcnuF epyT
1 1RDDA 1suBsserddA tuO SUB A
3 3RDDA 3suBsserddA tuO SUB A
5 5RDDA 5suBsserddA tuO SUB A
7 7RDDA 7suBsserddA tuO SUB A
8 9RDDA 9suBsserddA tuO SUB A
11 11RDDA 11suBsserddA tuO SUB A
31 31RDDA 31suBsserddA tuO SUB A
51 51RDDA 51suBsserddA tuO SUB A
71 71RDDA 71suBsserddA tuO SUB A
91 TUOKLC tuptuOkcoLCmetsyS tuO KLC A

B langiS .cseD .riD noitcnuF epyT
1 1ATAD 1suBataD O/I SUB M1PwA
3 3ATAD 3suBataD O/I SUB M1PwA
5 5ATAD 5suBataD O/I SUB M1PwA
7 7ATAD 7suBataD O/I SUB M1PwA
8 9ATAD 9suBataD O/I SUB M1PwA
11 11ATAD 11suBataD O/I SUB M1PwA
31 31ATAD 31suBataD O/I SUB M1PwA
51 51ATAD 51suBataD O/I SUB K01PB
71 8SC/ 8tceleSpihC tuO SUB A
91 W/R etirW/daeR tuO SUB K01PA

A langiS .cseD .riD noitcnuF epyT
2 91RDDA 91suBsserddA tuO SUB A
4 2RDDA 2suBsserddA tuO SUB A
6 4RDDA 4suBsserddA tuO SUB A
8 6RDDA 6suBsserddA tuO SUB A
01 8RDDA 8suBsserddA tuO SUB A
21 01RDDA 01suBsserddA tuO SUB A
41 21RDDA 21suBsserddA tuO SUB A
61 41RDDA 41suBsserddA tuO SUB A
81 61RDDA 61suBsserddA tuO SUB A
02 81RDDA 81suBsserddA tuO SUB A

B langiS .cseD .riD noitcnuF epyT
2 0ATAD 0suBataD O/I SUB M1PwA
4 2ATAD 2suBataD O/I SUB M1PwA
6 4ATAD 4suBataD O/I SUB 1*wA
8 6ATAD 6suBataD O/I SUB M1PwA
01 8ATAD 8suBataD O/I SUB M1PwA
21 01ATAD 01suBataD O/I SUB M1PwA
41 21ATAD 21suBataD O/I SUB M1PwA
61 41ATAD 41suBataD O/I SUB M1PwA
81 01SC/ 01tceleSpihC tuO SUB A
02 NIKLC tupnIkcolCzHk04 nI KLC 2*
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C langiS .cseD .riD noitcnuF epyT
1 SD/ ebortSataD tuO SUB/MDB 8*B
3 DNG dnuorG rwP RWP/MDB -
5 SSAP )desuton(hguorhTssaP 01*
7 TESER/ teseR O/I SUB/MDB 028PoB
9 GERV yrtiucriCotrewoPV3.3 nI RWP/MDB
11 NILV tupuOrotalugeRV3.3 tuO RWP
31 TABV tupnIyrettaBniaM nI RWP
51 2SCP 2tceleSpihCIPS O/I OIPG/IPSQ 9*oB
71 3SCP 3tceleSpihCIPS O/I OIPG/IPSQ 9*oB
91 1SCP 1tceleSpihCIPS O/I OIPG/IPSQ 9*oB
12 0SCP 0tceleSpihCIPS O/I OIPG/IPSQ 9*oB
32 9DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
52 8DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
72 5DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
92 4DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
13 A81STC remiTnoitcAelgniS O/I OIPG/RMT A
33 92DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
53 72DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
73 62DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
93 5QRI/ 5tseuqeRtpurretnI O/I OIPG/QRI 5*K01B
14 2QRI/ 2tseuqeRtpurretnI O/I OIPG/QRI 5*K01B
34 DXRSR )AIE(evieceR232SR nI TRAU GK5PISR
54 DXR/4QRI )SOMC(xR232SR/QRI nI TRAU 7*
74 STRSR )AIE(STR232SR tuO TRAU OSR
94 STCSR )AIE(STC232SR nI TRAU GK5PISR

C langiS .cseD .riD noitcnuF epyT
2 RREB rorrEsuB tuO SUB/MDB K01PB
4 TPKB/ tniopkaerB nI MDB K01P
6 EZEERF ezeerF tuO MDB A
8 ISD tupnIMDB NI MDB A
01 OSD tuptuOMDB tuO MDB A
21 NDHS/ nwodtuhS tuO RWP 3*
41 KBBV tupnIyrettaBpukcaB nI RWP
61 KCS kcolCIPS O/I OIPG/IPSQ 9*oB
81 ISOM tuOataDIPS O/I OIPG/IPSQ 9*oB
02 OSIM nIataDIPS O/I OIPG/IPSQ M1PoB
22 01DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
42 7DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
62 6DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
82 B41STC remiTnoitcAelgniS O/I OIPG/RMT A
03 A41STC remiTnoitcAelgniS O/I OIPG/RMT A
23 B81STC remiTnoitcAelgniS O/I OIPG/RMT A
43 82DTC remiTnoitcAelbuoD O/I OIPG/RMT oA
63 L13MTC daoLremiTlanretxE nI OIPG/RMT M1PA
83 EKAW/ puekaWlanretxE nI RWP 4*
04 7QRI/ 7tseuqeRtpurretnI O/I OIPG/QRI 5*K01B
24 KLCDOM ecruoSkcolCetanretlA O/I OIPG/KLC 6*K01B
44 DXTSR )AIE(timsnarT232SR tuO TRAU OSR
64 DXT/ )SOMC(timsnarT232SR tuO TRAU oB
84 STR/ )SOMC(STR232SR tuO TRAU M1PA
05 STC/3QRI )SOMC(STC/QRI nI TRAU 7*B

*1. DATA4 is pulled low with 10K during reset.

*2. CLKIN is connected to the 68338 EXTAL input for the 40kHz crystal. It is an extremely high impedance input and care
must be taken not to make unintentional connection to this pin, which would likely cause erratic behavior. Contact the factory
for information on using CLKIN with an external precision clock source.

*3. /SHDN is an output signal controlled by the power management circuitry. Your peripheral circuitry can monitor this signal,
but only with inputs having less than 100nA leakage and less than 100pF capacitance. When low, all of the CF1 circuitry is
powered off. Do not attempt to assert or load this line.

*4. /WAKE is input to the power management circuitry and is pull high with 1M to the internal VBAK volage. External
circuitry (coordinated with CF1 driver software) may use this line to pull the CF1 out of suspend mode.

*5. These lines must be left floating, or asserted high at reset.

*6. This line must be floating or asserted high at reset for normal operation. It may be pulled low during reset to disable the
onboard PLL clock oscillator and insert an external clock. Contact the factory for application notes.

*7. /RXD and /CTS are inputs to the 68338, but are normally driven by the RS232 driver chip. You can disable the RS232
driver under software control to allow the CF1 to run the UART at CMOS levels.

*8. DS comes out of reset as an active driving bus output, but is not used by the CF1 except when connected to a BDM
debugger. When your program gets control, you can define this line as a BUS signal (for decoding), an input signal (though
you must not drive into it until you redefine it), or an output signal. The convenient location and the fact that it is less useful as
a general purpose control line (since it flails at reset) makes this an ideal pin for diagnostics and timing or profiling your
functions with a scope using the fast I/O macros.

*9. All of the QSPI (PicoBUS) signals revert to inputs at reset which means they may assume any state, and that could be
trouble for attached SPI devices which could interpret reset flailing as commands, which in turn could have the SPI device do
something the CF1 would not like. You should add 10K to 100K pullups to the /CS lines of your SPI devices to prevent
trouble.

*10. The PASS pin does not connect to any circuitry on the CF1 and may be used to pass a signal from a top mounted
expansion board to another bottom mounted board.
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PPPPoooowwwweeeerrrr    CCCCoooonnnnnnnneeeeccccttttiiiioooonnnnssss

The CF1 has very flexible power management support circuitry
to simplify integration with your electronics. The onboard 3.3
volt linear regulator with reverse battery protection and thermal
current limiting that "floats" on the CF1 board to allow you to
bypass, augment, or reassign it to other circuitry. Normally,
you simply wire your positive supply to the VBAT input, then
jumper VLIN (the regulator output) to VREG.

An onboard power supervisor ensures that the CF1 will receive
an orderly reset and that the memory and real-time clock will
be preserved in the event of a power disruption.

A separate power managing controller lets the CF1 drop into a
SUSPEND mode where the system draws less than 10
microamps. It can wake and resume after a programmed delay
or on detection of /WAKE signal or CompactFlash card change
event.

C langiS .riD noitpircseD
3 DNG nI .cigol1FCehtfollarofdnuorglatigiddnaslangisrewop1FCehtfollarofnruterevitagenehtsisihT

31 TABV nI

ehtwollalliw1251TLehT.rotalugerraenil1251TLdraobnoehtotegatlovtupniCDdetalugernuehtsisihT
tupnisihT.stlov02-otnoitcetorprewopesreversedivorpdnastlov02ot6.3morfstupnihtiwkrowot1FC

draobnoehtgnisutonerauoyfidetcennocnutupnisihtevaeL.roticapacretlifmulatnatFu1aotstcennoc
.rotaluger

11 NILV tuO

fotuptuodetarasah1251TLehT.rotalugerraenil1251TLdraobnoehtmorfstlov3.3detalugerehtsisihT
otrefeR.egatlovtupnidnaerutarepmethtiwyravlliwtnerrucsuounitnoclautcaehttub,mumixamAm003

ynaotyltceridtcennoctonseodtuptuodetalugerehT.stimilgnitareporof2egapnosnoitacificepseht
1FCehtrewopotnoitcennocdraobffonahtiwGERVotderiwyllamronsidnastnenopmocdraobno

.roticapacretlifmulatnatFu01aotstcennoctuptuosihT.scinortcele

9 GERV nI

ynaybnevirdebyamtub,NILVotderiwyllamronsitI.scinortcele1FCehtotstlov3.3detalugerehtsisihT
ehtotstcennocoslatI.roticapacretlifmulatnatFu22draobnonaotstcennocGERV.ylppustlov3.3

3wolebspordtupniehtnehwKBBVotrevosehctiwsdnaUPCehtsteserhcihwrosivrepusrewop597XAM
.)00.3ot58.2(stlov

- FCV - rotsisergnitimiltnerrucmho01ahguorhtredaehhsalFtcapmoCehtsdeeflangisrewopylnodraobnosihT
.roticapacretlifmulatnatFu22nwostisahtI.GERVot

41 KBBV nI -laerehtsnurdnarosivrepusrewop597XAMehtotnisdeeftI.tupniylppusyrettabpukcabtlov3ehtsisihT
.stlov3wolebspordegatlovniamehtnehwMARSBK652dnakcolcemit

- KABV - MARSdnaCTRehtsdeefdnarosivrepusrewop597XAMehtmorfsemoclangisrewopylnodraobnosihT
.stlov3wolebspordegatlovniamehtnehwKBBVmorfdna,lamronsirewopniamnehwGERVmorf

7 TESER/ O/I mho028nahtiwGERVotdellupsisihT.scinortcele1FCehtsteserlangislanoitceridibniard-neposihT
.langissihttressanacreganamrewopCIPehtdnarosivrepusrewop597XAMehthtoB.rotsiser

21 NDHS/ tuO
rotinomnacyrtiucriclarehpirepruoY.yrtiucrictnemeganamrewopehtybdellortnoclangistuptuonasisihT

nehW.ecnaticapacFp001nahtsseldnaegakaelAn001nahtsselgnivahstupnihtiwylnotub,langissiht
.enilsihtdaolrotressaottpmettatonoD.ffoderewopsiyrtiucric1FCehtfolla,wol

82 EKAW/ nI
KABVlanretniehtotK033htiwhgihdellupsidnayrtiucrictnemeganamrewopehtottupniehtsisihT

fotuo1FCehtllupotenilsihtesuyam)erawtfosrevird1FChtiwdetanidrooc(yrtiucriclanretxE.egatlov
.edomdnepsus
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UUUUAAAARRRRTTTT    CCCCoooonnnnnnnneeeeccccttttiiiioooonnnnssss

The 68338 has a Serial Controller Interface
(SCI) that provides standard UART functions
at rates from 64 to 500 kbaud with advanced
error detection circuitry. The SCI supports
full or half duplex operation, double
buffering, optional parity generation and
detection, and wakeup on idle line or address
detection.

The CF1 has an onboard MAX3222 dual EIA
driver to interface directly to any standard
RS-232 terminal or device. Either or both the
receive and transmit drivers can be disabled
under software control to conserve power or
allow connection to alternate RS-485 or RS-422 drivers.

BIOS UART Support: The CF1 BIOS software handles port configuration, polled or buffered
receive and transmit, and flow control with several dozen high-level C functions. One of the example
projects that ships on the CF1 Developer's CD demonstrates how to stream incoming RS-232 data to a file
on the CompactFlash card at any standard BAUD rate while automatically dropping to less than 2mA
whenever the serial line idles. This particular example is 180 lines of C code, over 100 of which are just
comments and formatting.

RS-232 Wakeup Call: Both the RXD and CTS signals connect to interrupt
request pins on the 68338 to allow wakeup from deep sleep modes from any
UART activity. However, in the 10µA SUSPEND mode, power to the CPU is
completely off so we add the simple circuit at right to yank on the /WAKE line
when a UART character comes in. It may seem odd to tie the emitter of the NPN
transistor to VREG, but VREG actually looks like GROUND when the CF1 is in
SUSPEND, and this circuit keeps the WAKE line from flailing during normal operation.

2nd UART borrowing spare drivers: All of the
CMOS level UART signals are brought out to allow driver
replacement, and the RTS and CTS signals can be used for
EIA level flow control or reassigned to work as RXD and
TXD signals for a second external UART such as a
MAX3100 SPI UART shown. In the next section, you'll
see that this same technique can be used to expand to up to
14 additional UARTs.
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The 68338 has a powerful Queued Serial Peripheral
Interface that allows simple hardware expansion to over five
hundreds different SPI compatible devices. The circuit at
right demonstrates glueless expansion adding a second
UART (from the previous section) 11 A-D channels with 12-
bit resolution, 16 voltage output 10-bit D-A channels, and 32
individually programmable bidirectional digital I/O pins.

The table below lists some of the manufacturers of SPI
compatible devices and their product offerings. This is by no
means complete, but it does give you an idea of the
expansion possibilities just working the serial bus.

Allegro MicroSystems
American Microsystems
Analog Devices
Atmel
Burr-Brown
Catalyst
Dallas Semiconductor
Exar
Exel Microelectronics
Fujitsu Microelectronics
Harris Semiconductor
Linear Technology
Maxim
Micrel Semiconductor
Microchip Technology
Micro Linear
Motorola
National Semiconductor
Ramtron
Signal Processing Tech.
SGS-Thomson
Siemens
Sipex
Texas Instruments
Xicor
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The Counter Timer Module is actually a collection of separate
timer modules with specialized capabilities. Most of these are
independent single-action or double-action counter/timers that
connect to a bidirectional I/O pin on the CF1. The remaining
modules cooperate to provide the four timebases used by the
CTMs to perform their work.

A Single Clock Prescaler Submodule (CPSM) feeds one Free-
Running Counter Submodule (FCSM) and three Modulus
Counter Submodules (MCSM) with six individually selectable
clocks derived from the CPU system clock. The FCSM and
MCSM modules drive the four timebases from one of these
clocks or from an external clock. The FCSM has a fixed modulus
of 65536, while the MCSMs have loadable modulus registers
and load inputs for greater flexibility.

Single Action Submodules: The CTM has eight
SASMs, six connect to I/O pins from the CF1, while the other
two are used internally by the CF1 for simple I/O. Each SASM
can perform one of the following functions:

Input Capture: Capture the timebase on either edge of the I/O
pin and optionally generate an interrupt.

Output Port: Set or clear the I/O pin.

Output Compare: Set or clear the I/O pin on a timebase match
and optionally generate an interrupt.

Output Compare and Toggle: Toggle the I/O pin on a timebase match and optionally interrupt.

 
Double Action Submodules: The CTM has eleven DASMs which all connect to I/O pins from
the CF1. In addition to the functions listed for the SASMs, each DASM can perform one of the following
functions:

Input Pulse Width Measurement: Measure the time between leading and falling edges of the I/O pin
and optionally generate an interrupt on completion.

Input Period Measurement: Measure the time between two successive leading or falling edges of the
I/O pin and optionally generate an interrupt on completion.

Output Pulse Width Modulation: Generate a pulse width modulated waveform with selectable
resolutions of 7, 9, 11, 12, 13, 14, 15, or 16 bits.
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NOTE: All pins are 0.025" (0.64mm) gold-plated, phosphor-
bronze square posts, all centered on a 0.100" grid.


